
Лабораторная работа №4 

«Работа с прикладной программой CorelDRAW» 
 

Фигурный текст 

В общем случае фигурный текст представляет собой многоуровневый соединенный объект. С одноуровневыми соеди-

ненными объектами мы уже сталкивались, когда рассматривали кривые, состоящие из нескольких не связанных друг с другом 

ветвей, но ведущие себя как единый объект. Если такой объект выделить, а затем выбрать команду Arrange > Break Apart (Мон-

таж > Разъединить), он превращается в обычные объекты. Блок фигурного текста (иногда для краткости его называют просто 

фигурным текстом) в процессе разъединения ведет себя иначе. После первого разъединения он превращается в совокупность фи-

гурных текстов, каждый из которых соответствует строке исходного фигурного текста. Разъединение строки дает совокупность 

слов, и только разъединение слова дает совокупность фигурных текстов, каждый из которых будет «элементарным» — разъеди-

нить его не удастся, поскольку он состоит из одной младшей структурной единицы текста, символа. Структурную организацию 

фигурного текста иллюстрирует рис. 1.1.  

 

Рис. 1.1. Иерархия структурных единиц фигурного текста  

Возможна и обратная операция соединения блока фигурного текста из ранее построенных блоков при помощи команды Arrange 

> Combine (Монтаж > Соединить). 

Атрибуты фигурного текста 

Для каждого из символов (элементарных объектов фигурного текста) определены перечисленные ниже атрибуты.  

 Гарнитура (font). Гарнитурой называется рисунок символов алфавита, разработанный дизайнером шрифта. Каждый сим-

вол гарнитуры имеет свой номер. В стандартных текстовых гарнитурах рисунки отдельных символов имеют одинаковые 

номера, поэтому тексты, представляющиеся в компьютере последовательностью чисел, при форматировании различны-

ми текстовыми гарнитурами отображают в разных видах одни и те же буквы. Кроме стандартных текстовых гарнитур в 

CorelDRAW имеются гарнитуры графических символов, в которых тем же номерам соответствуют уже не буквы, а гра-

фические изображения (см. ниже). Чтобы гарнитурой можно было воспользоваться, она должна быть установлена в си-

стеме Windows. После этого ее имя появляется в раскрывающихся списках выбора гарнитур.  

 Кегль (size). Кеглем называется высота символов текста в пунктах. Иногда сочетание гарнитуры и кегля называют 

шрифтом (например, по умолчанию фигурные тексты выводятся шрифтом Avant Garde Bk ВТ 24 пункта). Влияние гар-

нитуры и кегля на внешний вид фигурного текста иллюстрирует рис. 1.2.  

 

Рис. 1.2. Влияние гарнитуры и кегля на внешний вид символов фигурного текста  

 Начертание (style). Начертанием называют модификацию рисунка символов текста за счет изменения толщины штрихов 

и их наклона. Для каждой модификации художник должен разработать отдельный рисунок гарнитуры, поэтому число 

начертаний в различных гарнитурах отличается. Стандартными начертаниями принято считать обычное (Normal), кур-



сивное (Normal-Italic), полужирное (Bold) и полужирное курсивное (Bold-Italic). Примеры начертаний представлены на 

рис. 1.3.  

 

Рис. 1.3. Стандартные начертания текста  

 Подчеркивание (underline), зачеркивание (strikethra) и подчеркивание (overscore). С помощью этих атрибутов описывает-

ся присутствие и характер линий, подчеркивающих, зачеркивающих или надчсркнвающих текст. Стандартными набора-

ми линий, использующихся для этих целей, в CorelDRAW считаются тонкая одиночная линия (Single Thin), толстая оди-

ночная линия (Single Thick) и двойная тонкая линия (Double Thin). Для каждого из наборов предусмотрена модификация, 

позволяющая подчеркивать только текст без пробелов (соответственно Single Thin Word. Single Thick Word и Double 

Thin Word). На рис. 1.4 представлены стандартные варианты подчеркивания. Отметим, что в CorelDRAW можно изме-

нять параметры стандартных наборов линий (толщину, расстояние от базовой линии текста, величину просвета между 

двойными линиями).  

 

Рис. 1.4. Стандартные варианты подчеркивания  

 Регистр символов (uppercase). Этот атрибут управляет отображением символов с учетом преобразования регистра. Оп 

может принимать три значения: без преобразования (None), капитель (Small CAPS) и капитализация (All CAPS). При 

включении преобразования капители все строчные символы имеют обычную высоту, но по рисунку совпадают с соот-

ветствующими прописными символами. Преобразование капитализации отображает вместо строчных символов их про-

писные аналоги в высоту прописного символа. Установка любого из значений атрибута не изменяет символов в самом 

тексте — меняется только способ их отображения.  

 Режим индекса (position). Этот атрибут управляет преобразованием символов при отображении в верхние (надстрочные) 

или нижние (подстрочные) индексы.  

 Смещение символов (character shift). В эту группу входят три атрибута: смещение по горизонтали (Horizontal), смещение 

по вертикали (Vertical) и смещение угловое (Rotation). Значения этих атрибутов задают величины смещения символов 

при отображении в блоке фигурного текста относительно их «штатного» положения. На рис. 1.5 в верхней строке для 



некоторых символов изменено смещение по вертикали, в средней — по горизонтали, в нижней — для одной буквы вве-

дены дополнительные горизонтальное и вертикальное смещения и задан поворот на 160°.  

 

Рис. 1.5. Смещение символов из исходных положений  

Для блока фигурного текста в целом определены следующие атрибуты.  

 Выравнивание (alignment). Этот атрибут управляет размещением слов в пределах строк блока фигурного текста. Он мо-

жет принимать одно из шести значений:  

o None (Отсутствует) — слова выравниваются по левой границе блока, но, задавая отрицательные значения сме-

щения по горизонтали, можно вывести отдельные символы за нее влево;  

o Left (По левому краю) — слова выравниваются по левой границе блока, если при этом отдельные символы сме-

щаются влево, то вместо их вывода за левую границу блока происходит смещение всей остальной строки впра-

во;  

o Center (По центру) — слова выравниваются так, чтобы середины всех строк блока совпадали с воображаемой 

вертикальной линией, расположенной посередине между его левой и правой границами;  

o Right (По правому краю) — слова выравниваются по правой границе блока, если при этом отдельные символы 

смещаются вправо, то вместо их вывода за правую границу блока происходит смещение всей остальной строки 

влево;  

o Full Justify (По ширине) — слова выравниваются так, чтобы первый символ первого слова каждой строки сов-

мещался с левой границей блока, а последний символ последнего слова строки — с правой границей блока (ис-

ключение делается только для случая, когда в последней строке остается единственное слово (или перенесенная 

с предыдущей строки часть слова) — оно выравнивается по левому краю);  

o Force Justify (Полное по ширине) — то же, что по ширине, но без каких-либо исключений.  

 Интерлиньяж (line space). Этот атрибут управляет расстоянием между смежными строками блока фигурного текста. Чис-

ленно интерлиньяж равен расстоянию между базовыми линиями смежных строк текста. По умолчанию эта величина ука-

зывается в CorelDRAW в процентах от высоты символов выбранного шрифта. Поскольку при разработке гарнитуры в 

высоту прописных символов текста включают и свободное пространство над ними, интерлиньяж 100 % означает, что 

расстояние между строками текста соответствует замыслу художника, разработавшего гарнитуру. В полиграфии для 

мелких кеглей это расстояние чаще всего увеличивают до 120 %, а для крупных иногда даже уменьшают.  

 Интервалы (space). В CorelDRAW имеется возможность принудительно изменять предусмотренные рисунком гарнитуры 

расстояния между смежными символами (Character) и между смежными словами (Word). Межсимвольное расстояние 

измеряется в процентах от ширины символа пробела использованного шрифта и по умолчанию равно нулю, то есть рас-

стояния между символами в словах соответствуют предусмотренным в гарнитуре. Увеличение межсимволыюго расстоя-

ния раздвигает символы, уменьшение — сближает. Такая процедура называется трекингом. Межсловное расстояние 

также измеряется в процентах от ширины пробела для данного шрифта, оно по умолчанию равно 100 %. Следует пом-

нить, что при выравнивании текста по обоим краям блока ширина пробела переменная и, естественно, не может точно 

соответствовать величине межсловного интервала.  

Создание блока фигурного текста 

Как фигурный, так и простой текст в CorelDRAW 11 строятся с помощью инструмента Text (Текст), но разными приемами. Па-

нель атрибутов после выбора инструмента Text (Текст) представленна на рис. 1.6.  



 

Рис. 1.6. Панель атрибутов для инструмента Text  

Чтобы начать ввод блока фигурного текста, достаточно щелкнуть мышью в той точке страницы, где должен разместиться 

текст. На странице появится текстовый, курсор в виде вертикальной черты. Если включен режим отображения непечатаемых 

символов, то после ввода первого символа нового блока с клавиатуры вслед за ним появится символ конца абзаца (который в 

блоке фигурного текста производит только перевод на следующую строку, поскольку в фигурном тексте абзацы не выделяются). 

При необходимости перехода на новую строку следует нажать клавишу Enter.  

Чтобы ускорить процесс ввода (особенно на медленных компьютерах) пли при необходимости импортировать текст во 

вновь создаваемый блок фигурного текста, можно воспользоваться окном, которое раскрывается после щелчка на кнопке режима 

ввода и редактирования па панели атрибутов (рис. 1.7). Расположенные в верхней части этого диалогового окна элементы управ-

ления дублируют соответствующие элементы управления панели атрибутов и позволяют назначать формат вновь вводимого тек-

ста в процессе ввода, не закрывая диалоговое окно. Особую роль играет кнопка с изображенной на пей латинской буквой F — 

она открывает диалоговое окно Format Text (Форматирование текста), предоставляющее пользователю доступ ко всем средствам 

форматирования фигурного текста, в том числе к тем из них, которые недоступны на панели атрибутов (рис. 1.8).  

 

Рис. 1.7. Диалоговое окно Edit Text  



 

Рис. 1.8. Вкладка Character диалогового окна Format Text  

Вкладки диалогового окна перечислены ниже.  

 Вкладка Character (Символы) содержит следующие элементы управления атрибутами, определяющими внешний вид 

символов текста:  

o раскрывающийся список Font (Гарнитура) содержит наименования установленных в системе гарнитур, доступ-

ных для форматирования текста;  

o счетчик Size (Кегль) определяет высоту символов текста;  

o раскрывающийся список Style (Стиль) позволяет выбрать один из вариантов начертания;  

o раскрывающиеся списки Underline (Подчеркивание), Strikethru (Перечеркивание) и Overscore (Подчеркивание) 

позволяют выбрать желаемое значение для любого из вариантов дополнения символов текста горизонтальными 

линиями;  

o раскрывающийся список Uppercase (Регистр) позволяет задавать преобразование символов текста при отображе-

нии в капитель или прописные;  

o раскрывающийся список Position (Индекс) позволяет переводить символы текста в верхний или нижний индекс;  

o раскрывающийся список Script (Скрипт) позволяет дополнительно корректировать интерлиньяж для работы с 

языками, предусматривающими диакритические знаки.  

 Вкладка Paragraph (Абзац) содержит группу переключателей, определяющих порядок размещение слов в пределах строк 

блока фигурного текста. Функционально дублирует кнопки выравнивания панели атрибутов. Здесь же расположены три 

счетчика, управляющих величиной межспмволыюго (Character) и межсловного (Word) интервалов, а также интерлинья-

жем (Line).  

Остальные вкладки диалогового окна рассматриваются ниже, в разделе, посвященном простому тексту, поскольку для работы с 

фигурным текстом они не предоставляют никаких возможностей. Расположенные в нижней части диалогового окна Edit Text 

(Редактирование текста) кнопки раскрывают дополнительные диалоговые окна и меню.  

 Import (Импортирование). Эта кнопка раскрывает диалоговое окно выбора текстового документа, содержимое которого 

после завершения импортирования будет добавлено в месте расположения курсора к имеющемуся к этому моменту в 

блоке тексту. В комплект поставки CorelDRAW входят фильтры, позволяющие импортировать тексты, представленные в 

файлах большинства распространенных форматов.  

 Options (Дополнительно). Щелчок на этой кнопке раскрывает контекстное меню (рис. 1.9), дающее доступ к вспомога-

тельным инструментам для работы с текстом, аналогичным имеющимся в любом достаточно развитом текстовом про-

цессоре.  



 

Рис. 1.9. Контекстное меню вспомогательных инструментов для работы с текстом  

Команда Select All (Выделить все) выделяет весь текст блока. Вторая группа команд позволяет исправлять ошибки выбора реги-

стра символов при вводе, осуществлять контекстный поиск и замену частей текста. Третья группа команд раскрывает диалоговые 

окна проверки орфографии, проверки грамматики и тезауруса. Эти команды работают практически так же, как в любом тексто-

вом процессоре. Четвертая группа состоит из двух команд, управляющих отображением в верхней части окна редактирования 

списка выбора гарнитур и кнопок форматирования. Последняя команда контекстного меню дает доступ к диалоговому окну 

настройки параметров инструмента Text (Текст).  

Большинство приемов редактирования и форматирования текста не слишком отличаются от приемов работы с текстовым про-

цессором.  

Упражнение 1. Ввод, редактирование и форматирование фигурного текста 

Выполняя это упражнение, мы познакомимся с приемами создания, соединения и разъединения блоков фигурного текста, а также 

с приемами форматирования и редактирования их содержимого.  

1. Начните с создания нового документа CorelDRAW. Выберите в наборе инструментов инструмент Text (Текст) и щелкните 

мышью в левом верхнем углу страницы. В месте щелчка появится вертикальная черточка — текстовый курсор. На панели атри-

бутов выберите гарнитуру, содержащую символы кириллицы (например, Arial), установите кегль 48 и введите с клавиатуры сле-

дующий текст, разделяя строки нажатием клавиши Enter:  

Жили у бабуси Два веселых гуся: Один - серый. Другой - белый, Два веселых гуся  

2. На панели атрибутов щелкните на кнопке режима отображения непечатаемых символов и обратите внимание на то, что вместо 

пробелов выводятся маленькие кружки на середине высоты строки, а на концах строк появились символы конца абзаца. Перета-

щив по второй строке указатель инструмента Text  

(Текст), выделите все ее символы, кроме двоеточия, скопируйте выделенный текст в буфер обмена командой Edit > Сору (Правка 

> Копировать) или соответствующей кнопкой стандартной панели инструментов, затем щелчком мыши установите текстовый 

курсор в конец последней строки. Для перехода на новую строку нажмите клавишу Enter, а потом вставьте содержимое буфера 

обмена командой Edit > Paste (Правка > Вставить) или соответствующей ей кнопкой стандартной панели инструментов. Как ви-

дите, операции ввода и копирования текста не отличаются от применяющихся при работе с текстовым процессором.  

3. Теперь вставим в текст специальный символ. Установите текстовый курсор в точку, где должен появиться символ (после слова 

«серый»), и откройте при- стыковываемое окно Insert Character (Вставка символа) командой Text > Insert Character (Текст > 

Вставка символа). В раскрывающемся списке пристыко- вываемого окна выберите название гарнитуры — Animalsl (если эта гар-

нитура не установлена на вашем компьютере, ее можно найти в комплекте поставки CorelDRAW), а в расположенной ниже па-

литре найдите изображение нужного символа — в данном случае, гуся (рис. 1.10). Перетащите это изображение мышью в преде-

лы прямоугольной рамки выделения, окружающей блок фигурного текста. После отпускания кнопки мыши гусь займет свое ме-

сто в тексте. Чтобы черная заливка изображения не диссонировала с текстом, выделите вставленный символ и щелкните мытью 

на образце экранной палитры с серым цветом.  

Примечание  

Тем же способом в фигурный текст можно вставить не только символы специальных гарнитур, но и любое векторное изображе-

ние. В этом случае оно перетаскивается указателем инструмента Text (Текст) внутрь текста не из пристыковываемого окна, а 

непосредственно со страницы. Перед вставкой размеры изображения будут приведены к стандартным размерам символа текуще-

го шрифта, и в дальнейшем изменения кегля текста будут влиять на высоту вставленного таким образом изображения. Такие 



изображения называются вложенными в текст. Редактировать подобное изображение стандартными приемами CorelDRAW нель-

зя.  

 

Рис. 4.10. Пристыковываемое окно Insert Character и вставка символа в фигурный текст  

4. Точно так же вставьте в конец следующей строки еще одного гуся, выделите его и щелкните на белом образце экранной па-

литры — гусь станет белым. Перейдите в окно редактирования текста щелчком на соответствующей кнопке панели атрибутов 

(см. рис. 1.6). Выбрав команду Options > Replace Text (Дополнительно > Заменить текст), откройте диалоговое окно контекстной 

замены и замените все вхождения слова «веселых» словом «нескучных», введя соответствующие значения в поля диалогового 

окна и щелкнув на кнопке Replace All (Заменить все).  

5. Выделяя отдельные, произвольно выбранные части инструментом Text (Текст), измените их кегли и гарнитуры. Проверьте, 

какое влияние оказывают на фигурный текст кнопки режимов выравнивания. Воспользуйтесь диалоговым окном форматирова-

ния для установки значения интерлиньяжа равным 120 % от кегля.  

6. В заключение разъедините блок фигурного текста. Поскольку этот блок нам еще понадобится в целом виде для следующих 

упражнений, подготовьте его копию: выберите инструмент Pick (Выбор), щелкните им па блоке фигурного текста и перетащите 

его на свободное место страницы. Перед тем как отпустить кнопку мыши, щелкните ее правой кнопкой. Обратите внимание на 

расположение маркеров рамки выделения (они располагаются по краям блока фигурного текста) и на текст в строке состояния. 

Выберите команду Arrange > Break Apart (Монтаж > Разъединить). Теперь маркеры рамки выделения охватывают только первую 

строку бывшего блока фигурного текста. Повторите операцию разъединения еще два раза, разбивая строку на слова, а затем — 

слово на отдельные символы. При этом каждый раз в результате разъединения получаются блоки фигурного текста.  

Подсказка  

Разъединение блоков фигурного текста чаще всего приходится выполнять перед их преобразованием в кривые. Такое преобразо-

вание часто приводит к появлению соединенных кривых с огромным количеством узлов, с которыми даже мощные компьютеры 

справляются с большим трудом, не говоря уже о практически неизбежных в этом случае проблемах при печати. Поэтому старай-

тесь, чтобы в получающихся объектах было не более 400-500 узлов.  

Простой текст 

Так же как фигурный, простой текст представляет собой многоуровневый соединенный объект, но уровней, которые 

простой текст проходит при разъединении, больше, чем у фигурного текста. При разъединении большого объема простого текста 

могут получаться следующие структурные единицы: колонки текста, пункты перечисления, абзацы, строки, слова, символы. 

Кроме того, в отличие от фигурного текста простой текст не может располагаться непосредственно на печатной странице. В 

CorelDRAW любой простой текст располагается внутри особого объекта — рамки простом текста (paragraph text frame). При по-

мощи связен рамки могут образовать составной объект — цепочку рамок простого текста, отдельные элементы которой могут 

размещаться даже на различных страницах документа CorelDRAW. Базовая форма рамки простого текста — прямоугольник, но в 

процессе последующих преобразований эти прямоугольники могут принимать произвольные формы (рис. 1.11).  



 

Рис. 1.11. Цепочка рамок простого текста. Связи рамок отображены в виде стрелок  

Такой подход может показаться странным пользователям текстового процессора, в котором рамки обычно используются 

для выделения на странице места для рисунка или диаграммы, но он хорошо знаком пользователям редакционно-издательских 

систем. Одной из наиболее популярных систем компьютерной подготовки изданий является Corel VENT LIRA, и принятая в ней 

модель рамок простого текста практически полностью определила механизмы работы с простым текстом и в CorelDRAW. Сред-

ствами этой программы вполне можно сверстать и подготовить к печати небольшое книжное издание.  

Создание и редактирование простого текста 

Простой текст создается при помощи того же инструмента, что фигурный, а именно — инструмента Text (Текст). Прав-

да, создание простого текста предполагает еще одно предварительное действие — создание рамки простого текста. Поэтому по-

сле выбора инструмента Text (Текст) в наборе инструментов следует переместить указатель мыши в точку, где предполагается 

разместить один из углов будущей рамки, и перетащить его по ее диагонали. После отпускания кнопки мыши па экране появится 

изображение рамки выбранных габаритов, внутри которой расположится текстовый курсор в виде вертикальной черты. Можно 

приступать к вводу текста с клавиатуры.  

При вводе простого текста поведение CorelDRAW иное, чем при вводе фигурного текста. Во-первых, переход на новую 

строку определяется уже не пользователем, а автоматически, по мере достижения текстом правой границы рамки, причем нажа-

тие клавиши Enter означает переход не к следующей строке, а к следующему абзацу, который является более крупной структур-

ной единицей текста, чем строка. Во-вторых, когда вводимый текст достигнет нижней границы рамки, текстовый курсор пропа-

дает и вновь вводимого текста больше не видно. Из этого не следует, что текст не вводится — он лишь не отображается в преде-

лах рамки.  

Из-за этих особенностей при вводе значительного объема простого текста удобнее пользоваться диалоговым окном Edit Text (Ре-

дактирование текста), которое открывается после щелчка на соответствующей кнопке панели атрибутов.  

Подсказка  

Если для работы над изображением требуется простой текст большого объема, удобнее вводить его с помощью текстового про-

цессора, а впоследствии импортировать в CorelDRAW, воспользовавшись кнопкой Import (Импортирование) диалогового окна 

Edit Text (Редактирование текста). В одиннадцатой версии появилась возможность при импортировании текста, подготовленного 

с помощью текстового процессора, сохранять исходное форматирование абзацев и символов, только форматирование символов 

или вставлять импортируемый текст как последовательность символов, не имеющую собственного форматирования.  

Чтобы отредактировать простой текст, можно либо щелкнуть на нем указателем инструмента Text (Текст), после чего внутри 

рамки появится текстовый курсор, либо щелкнуть на рамке указателем инструмента Pick (Выбор) и воспользоваться диалоговым 

окном Edit Text (Редактирование текста), раскрыв его щелчком на кнопке панели атрибутов.  

Создание цепочки связанных рамок 

Цепочками связанных рамок простого текста пользуются для того, чтобы разместить одни текстовый фрагмент в нескольких ме-

стах одной страницы или на разных страницах документа. Речь идет не о размещении копий, а о продолжении текста при пере-

ходе из одной рамки в другую (см. рис. 1.11).  

Если текст, содержащийся в рамке, отображается в ней не полностью, то индикатор, расположенный в середине нижней границы 

рамки, принимает вид прямоугольника со стрелкой, направленной вниз. После щелчка мышью на этом индикаторе указатель ин-

струмента принимает форму листа с текстом (рис. 1.12), он как бы «заряжается» текстом.  



 

Рис. 1.12. Рамка с индикатором неразмещенного текста и «заряженный» текстом указатель инструмента  

Чтобы добавить в цепочку новую рамку, остается только перетащить указатель по ее диагонали (рис. 1.13).  

 

Рис. 1.13. Вновь созданная рамка простого текста соединяется стрелкой со своей предшественницей в цепочке  

Рамки, входящие в состав одной цепочки, соединяются цветными стрелками, которые отображаются только па экране, а на пе-

чать не выводятся. По форме верхних и нижних индикаторов можно судить о местоположении рамки в цепочке и наличии в ней 

неразмещенного текста. У первой рамки цепочки верхний индикатор пустой. Если рамка в цепочке не последняя, ее нижний ин-

дикатор выглядит как миниатюрная страница с текстом; если рамка не первая в цепочке, ее верхний индикатор выглядит как ми-

ниатюрная страница с текстом. Наконец, если рамка последняя, ее нижний индикатор пуст или содержит в себе стрелку, направ-

ленную вниз (если имеется неразмещенный текст).  

Если необходимо, чтобы следующая рамка в цепочке имела форму, отличную от прямоугольника, следует вначале построить 

замкнутый криволинейный объект желаемой формы, а затем «зарядить» указатель инструмента текстом, щелкнув на нижнем ин-

дикаторе последней рамки цепочки. Теперь при перемещении указателя внутрь замкнутого криволинейного объекта он примет 

форму широкой стрелки, направленной вправо. После щелчка на объекте таким указателем создается рамка, совпадающая с объ-

ектом но форме, — текст заключается внутрь объекта (рис. 1.14).  

 

Рис. 1.14. Создание рамки простого текста произвольной формы  

 



Примечание  

В результате описанной выше процедуры создается составной объект, состоящий из замкнутой фигуры (управляющий объект) и 

прямоугольной рамки, заключенной в оболочку, по форме совпадающей с управляющим объектом (оболочки рассматриваются в 

последующих уроках). После построения рамки в оболочке управляющий объект больше не нужен, так как в отличие, например, 

от суперлинии его изменение не оказывает влияния на форму рамки простого текста, заключенной в оболочку. Поэтому состав-

ной объект можно отделить командой Arrange > Break Apart (Монтаж > Разъединить) и удалить замкнутую кривую. При этом 

рамка в оболочке остается в составе цепочки рамок простого текста.  

Если после «зарядки» указателя инструмента текстом выполнить щелчок не на замкнутом объекте, а на разомкнутой кривой, то 

будет построена прямоугольная рамка простого текста, по габаритам совпадающая с рамкой выделения кривой, после чего нача-

ло попавшего в нее текста (не далее чем до первого конца абзаца) размещается вдоль этой кривой (см. урок 5), а остальной текст 

остается неразмещенным (см. рис. 1.11).  

Примечание  

В этом случае также создается соединенный объект, но другого типа (текст, размещенный на кривой). Поэтому при отделении 

управляющего объекта (кривой) рамка простого текста приобретает свою исходную прямоугольную форму. Таким образом, 

управляющую кривую удалять нельзя, но ее можно сделать невидимой, отменив обводку кривой.  

Чтобы удалить рамку, входящую в состав цепочки, достаточно выделить ее инструментом Pick (Выбор) и нажать клавишу Del. 

Если удаляется последняя рамка цепочки, содержавшийся в ней текст будет вытеснен в предпоследнюю рамку, сохраняясь в ней 

как неразмещенный. При удалении первой рамки цепочки текст вытесняется во вторую и размещается в ней, из второй — в тре-

тью и т. д. Избыток текста в цепочке всегда находится в последней рамке (как неразмещенный текст). При удалении промежу-

точной рамки цепочки автоматически создается новая связь, соединяющая предшествующую ей рамку и следующую за ней рам-

ку. Текст из удаленной рамки вытесняется «вниз» по цепочке.  

Построенную цепочку связанных рамок простого текста можно «расцепить» в любом месте. Для этого достаточно описанным 

выше приемом «зарядить» указатель инструмента текстом, щелкнув на нижнем индикаторе рамки, и построить новую рамку на 

свободном месте. При этом весь текст из «хвоста» цепочки переносится в новую рамку, а рамки, входящие в состав «хвоста», 

остаются пустыми, по сцепленными друг с другом. Если впоследствии на первой «отцепленной» рамке будет выполнен щелчок 

«заряженным» указателем инструмента (в виде широкой стрелки), все отцепленные рамки будут вновь наполнены текстом.  

Рамки, входящие в состав цепочки, могут размещаться на различных страницах документа CorelDRAW. При создании рамки на 

другой странице следует после «зарядки» указателя инструмента текстом перейти на эту страницу и создать на ней новую тек-

стовую рамку. Если трс-буется перенести ранее созданную текстовую рамку на другую страницу, необходимо вначале перета-

щить ее инструментом Pick (Выбор) за пределы страницы на рабочий стол, перейти на другую страницу и перетащить туда рамку 

с рабочего стола.  

Так можно размещать весьма значительные объемы простого текста в связанной цепочке рамок, расположенных в пределах од-

ной или нескольких страниц документа CorelDRAW, а также на рабочем столе.  

Обтекание текстом 

Обтеканием простым текстом называется режим, при котором текст в рамках размещается с учетом не только конфигурации этих 

рамок, но и формы объектов, перекрывающихся с рамками цепочки. Этот режим включается для всех объектов CorelDRAW, у 

которых атрибут обтекания имеет значение, отличное от None (Без обтекания). Этот атрибут может быть установлен с помощью 

меню, связанного с кнопкой Wrap Paragraph Text (Обтекание простым текстом) панели атрибутов (рис. 1.15). Кроме пего может 

задаваться зазор, то есть минимальное расстояние между текстом и обтекаемым объектом.  



 

Рис. 4.15. Меню режимов обтекания простым текстом  

Все режимы обтекания делятся на две группы: по контуру объекта (в качестве границы области, в которой текст не размещается, 

выступает граница объекта произвольной конфигурации) и по рамке выделения (в качестве границы области, в которой текст не 

размещается, выступает габаритный прямоугольник объекта, совпадающий по размерам с его рамкой выделения). Примеры об-

текания текстом приведены на рис. 1.16 и 1.17.  

 

Рис. 1.16. Обтекание текстом по контуру объекта: без обтекания (а), обтекание слева (б). обтекание справа (в), обтекание вокруг 

(г)  

Сочетая приемы включения в цепочку рамок простого текста рамок произвольной формы и обтекания текстом объектов, пере-

крывающихся с рамками, можно добиться любого, даже самого замысловатого варианта размещения текста, соответствующего 

художественному замыслу автора.  



 

Рис. 1.17. Обтекание текстом по рамке выделения объекта: обтекание слева (а), обтекание справа (б), обтекание вокруг (в), обте-

кание вразрез (г)  

Атрибуты простого текста 

Практически все атрибуты фигурного текста имеются и у простого текста, но за счет того, что у последнего больше структурных 

единиц, на вкладках диалогового окна Format Text (Форматирование текста) для простого текста появляются дополнительные 

элементы управления, которые и рассматриваются ниже.  

Вкладка Character (Символы) в диалоговом окне Format Text (Форматирование текста) для простого текста выглядит так же, как 

для фигурного (см. рис. 1.8).  

На вкладке Paragraph (Абзац) диалогового окна Format Text (Форматирование текста) для простого текста по сравнению с такой 

же вкладкой для фигурного текста доступны дополнительные элементы управления (рис. 1.18).  

 



Рис. 1.18. Вкладка Paragraph диалогового окна Format Text для простого текста  

 Кнопка Settings (Установки) открывает диалоговое окно со счетчиками Мах. word spacing (Максимальный интервал 

между словами), Мin. word spacing (Минимальный интервал между словами) и Max. char spacing (Максимальный интер-

вал между символами). Эти счетчики позволяют более гибко управлять выравниванием текста в режимах Full Justify (По 

ширине) и Force Justify (Пол- нос по ширине), регулируя плотность верстки текста (рис. 1.19).  

 

Рис. 1.19. Элементы управления интервалами для простого текста во вспомогательном диалоговом окне  

 Группа счетчиков Spacing (Интервалы) содержит счетчики Before paragraph (Перед абзацем) и After paragraph (После аб-

заца), которые позволяют создавать просветы между абзацами, называемые в полиграфии отбивками. При работе с про-

стыми текстами больших объемов значения этих атрибутов подбираются вместе с другими атрибутами в процессе поли-

графической настройки макета для достижения наибольшей удобочитаемости. По умолчанию интервал перед абзацем 

устанавливается равным обычному межстрочному интервалу, а после абзаца — равным нулю.  

 Кнопка Hyphenation Settings (Установки переноса) открывает вспомогательное диалоговое окно, в котором содержатся 

перечисленные ниже элементы управления процессом переноса слов (рис. 1.20).  

 

Рис. 1.20. Диалоговое окно Hyphenation Settings  

o Флажок Automatic hyphenation (Автоматическая расстановка переносов) включает режим автоматической рас-

становки переносов для слов простого текста (но умолчанию выключенный) и делает доступными другие эле-

менты управления диалогового окна.  

o Флажок Break capitalized (Разбивать прописные) отменяет включенный по умолчанию режим запрета на перенос 

для слов из прописных символов.  

o Счетчик Hot zone (Зона переноса) задает ширину зоны переноса — полосы, примыкающей к правой границе 

рамки простого текста. Если в процессе верстки слово не помещается в строку, то в режиме автоматического пе-

реноса проверяется, где находится начало этого слова. Если оно попадает в зону переноса, слово целиком пере-

мешается на следующую строку. Если начало слова находится левее зоны переноса, предпринимается попытка 

перенести его часть.  

Внимание  

Чем уже зона переноса, тем больше будет количество строк, оканчивающихся знаком переноса, и тем плотнее будут строки тек-

ста.  

o Счетчик Min. word length (Минимальная длина слова) задает минимальное количество символов в слове, которое 

может быть перенесено (по умолчанию — шесть символов).  

o Счетчики Min. characters before (Минимальное число символов до) и Min. characters after (Минимальное число 

символов после) задают минимальное количество символов слова, которое может остаться на строке соответ-

ственно до и после знака переноса.  

 Группа счетчиков Indents (Отступы) позволяет задавать втяжки и абзацные отступы.  

o Счетчик Left (Левый) задает величину левой втяжки — расстояния от левого края рамки простого текста до вер-

тикальной линии, но которой выравниваются первые символы строк абзаца (кроме первой, выравнивание кото-

рой задается отдельно).  

o Счетчик Right (Правый) задает величину правой втяжки — расстояния от правого края рамки простого текста до 

вертикальной линии, по которой выравниваются последние символы строк абзаца (кроме первой, выравнивание 

которой задается отдельно).  

o Счетчик First line (Первая строка) задает величину левой втяжки для первой строки абзаца. Согласованно регу-

лируя значения левой втяжки для первой строки и для остальных строк, можно управлять величиной абзацного 

отступа — смещением первого символа первой строки абзаца относительно линии левой втяжки.  

 

 



Внимание  

Значения, содержащиеся в счетчиках группы Indents (Отступы), могут быть только положительными, но следует иметь в виду, 

что соответствующие расстояния всегда измеряются от края рамки к ее середине. В этом CorelDRAW отличается, например, от 

текстового процессора Word (и большинства других), в котором знак при величине втяжки определяет направление отсчета рас-

стояния.  

Упражнение 2. Работа с простым текстом 

В качестве упражнения для освоения приемов работы с простым текстом создадим макет условного меню еще более условного 

кафе. Вид макета представлен на рис. 1.21 — как видите, мы пока не очень заботимся о его художественных достоинствах.  

Чтобы не сковывать творческую фантазию, приведем лишь самые общие указания по этапам работы.  

1. Создайте новую страницу в открытом документе CorelDRAW. Выберите инструмент Text (Текст), постройте в верхней части 

страницы блок простого текста произвольных размеров и перейдите в диалоговое окно Edit Text (Редактирование текста), щелк-

нув на соответствующей кнопке панели атрибутов.  

2. Выберите в раскрывающемся списке гарнитур любую, включающую символы кириллицы (например, Arial), и введите текст 

меню, разбивая его на абзацы нажатием клавиши Enter. Названия разделов меню и каждого из блюд должны располагаться в от-

дельных абзацах. По завершении ввода закройте диалоговое окно Edit Text (Редактирование текста).  

 

Рис. 1.21. Макет меню  

3. Задайте гарнитуры и кегли для отдельных абзацев. Дело это творческое — помните, что рисунок гарнитуры создает общее 

настроение макета, а от выбора кеглей для заголовков различных уровней зависит визуальная сбалансированность макета. Тех-

нически это выполняется следующим образом. Продолжая работать в диалоговом окне Edit Text (Редактирование текста), пере-

тащите указатель мыши по части текста, подлежащего форматированию, чтобы выделить его. Выделенный текст отображается 

на темном фоне. Затем в раскрывающихся списках гарнитур и кеглей выберите желаемые альтернативы.  

4. Устанавливая текстовый курсор в абзацы заголовков разделов меню, задайте параметры буквиц (в данном макете заголовки 

невелики по длине, и целесообразно указать высоту буквиц не более двух строк). Для этого вначале щелкните на кнопке панели 

атрибутов с изображением буквицы, а затем откройте диалоговое окно форматирования щелчком на кнопке в диалоговом окне 

Edit Text (Редактирование текста). Перейдя на вкладку эффектов, установите желаемую высоту буквицы.  

5. Выделяя абзацы, соответствующие названиям блюд каждого из разделов меню, задайте для них маркеры списка. В данном ма-

кете использованы маркеры из символов специальной гарнитуры Food. По завершении форматирования закройте диалоговое ок-

но Edit Text (Редактирование текста).  

6. Постройте цепочку связанных рамок простого текста. Рамок в цепочке может быть либо шесть, либо три — в последнем слу-

чае текст в двух последних рамках придется размещать в несколько колонок. Цепочку стройте, «заряжая» указатель инструмента 

Pick (Выбор) щелчком на нижнем индикаторе последней рамки цепочки. Выбирайте расположение рамок и их размеры в соот-

ветствии с макетом, приведенным на рисунке. Перетаскивая тем же инструментом маркеры рамки выделения, отрегулируйте 

размеры рамок простого текста таким образом, чтобы в первой из них разместился заголовок меню, а в последующих — по од-

ному из его разделов.  

7. Сохраните документ CorelDRAW в файле с именем texts.cdr.  

 


